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Úvod

Cíl knihySvět výpočtů tabulek a grafů, to je program Microsoft Excel. Proniknout do tohoto světa, do jeho tajů,

kouzel, a hlavně proniknout do možností využití Excelu, je cílem knihy, jež jste právě otevřeli.

Společnost Microsoft přichází v poměrně pravidelných intervalech s novými, vylepšenými verzemi

kancelářského balíku Microsoft Office. Na závěr roku 2003 se na českém trhu objevila verze Micro−

soft Office 2003, která následuje po dřívějších verzích 2000 a XP. Tabulkový procesor Excel 2003,

jemuž je věnována tato kniha, je standardní součástí všech Office. Nová verze Office se liší

od předchozích verzí v několika vylepšeních, mezi nimiž je např. podpora formátu XML, doplnění

nových funkcí apod. Změnou, které si však všimne každý uživatel na první pohled, je změna desig−

nu. Nový vzhled Office, resp. jejich prostředí je více zakulacenější a uživatelsky přátelštější.

Práce s daty, jejich analýzy, vyhodnocování a v neposlední řadě také jejich grafické znázornění

do grafů či obrázků, je doménou tabulkových procesorů. Program Microsoft Excel patří k těm nejví−

ce používaným. Výhody Excelu spočívají především v jednoduchosti a přehlednosti ovládání, široké

nabídce funkcí a maximální přizpůsobivosti uživateli. Dostanete−li se v knize až na poslední stránky,

neměla by vás „překvapit“ žádná tabulka, žádný graf, ani žádná funkce. Excel se stane vaším každo−

denním pomocníkem, bez jehož spolupráce si některé činnosti ani nebudete umět představit.

Nová verze Office

Doména tabulkových
procesorů
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Úvod

Komu je kniha určena
Kniha Excel 2003 z edice podrobný průvodce začínajícího uživatele je určena především začáteční−

kům, kteří s Excelem přicházejí poprvé do styku. Mnoho informací v knize naleznou také uživatelé,

kteří s Excelem již zvládnou některé základní činnosti, ale přecházejí na novou verzi programu

a chtěli by se stát pokročilejšími uživateli. Všichni čtenáři bez rozdílu by již ovšem měli umět

používat Windows, znát základní principy práce s počítačem. Knihu využijí i uživatelé starších verzí

programu, protože základy používání Excelu jsou společné pro všechny verze. Kniha je doplněna

o anglické popisky nabídek, funkcí, příkazů a dialogových oken, což ocení uživatelé, pracující

v zahraničních firmách se software v anglické verzi.

Na zhruba 200 stranách knihy najdete nezbytné a potřebné informace a praktické návody pro vlastní

práci s programem, mnoho rad tipů a postupů pro zefektivnění práce, a také několik dalších námětů

pro vlastní využívání Excelu. Autor publikací, jež jsou určeny začínajícím uživatelům stojí vždy před

otázkou, zda zmínit v knize více témat v náznacích, nebo naopak probrat jen některé možnosti

programu do větší hloubky. Vybrala jsem si cestu první; chtěla bych v knize představit co nejvíce

témat tak, aby čtenář získal potřebný základ pro svoji další činnost. Jinými slovy, po přečtení knihy

se stanete pokročilými uživateli, kteří dokáží s Excelem dobře a efektivně pracovat, a tak ho využívat

při své každodenní práci. I tak se budeme některým oblastem věnovat pouze okrajově. Kniha je

psána stylem, jenž je postaven na příkladech a konkrétních ukázkách. Pokud se tedy v knize hovoří

například o konkrétních dialogových oknech, je připojen obrázek, na němž toto dialogové okno

vidíte. V případě, že si vysvětlovaná problematika vyžaduje i konkrétní ukázku, je tato uvedena

v cvičném souboru příkladů, který si můžete stáhnout z internetové adresy nakladatelství

www.grada.cz. Příklady jsou uloženy v jednom souboru, v číslovaných listech. Abyste si mohli

zopakovat právě probranou tématiku, je na konci každé z kapitol doplněno shrnutí a cvičné otázky.

Co je obsahem knihy? První kapitola vám představí samotný program Microsoft Excel, jeho výhody,

možnosti spouštění a ovládání. Ve druhé kapitole si vytvoříte první dokument, naučíte se ho ukládat

a opětovně otevírat. Třetí a čtvrtá kapitola představí prostředí Excelu, seznámíte se s buňkou, listem

a sešitem, zjistíte, jak je lze upravovat a formátovat a v neposlední řadě i prakticky využívat. Zadává−

ní dat a funkcí do tabulky je obsahem páté kapitoly. Šestá kapitola vás naučí, jak funkce používat

a jak s nimi správně pracovat. Data nestačí pouze do Excelu vložit, je třeba je i správně naformátovat

a zobrazit, proto se v sedmé a osmé kapitole setkáte s formáty tabulek a se způsoby zobrazení dat

v grafu. Jak si svá data správně vytisknout na tiskárně, se dozvíte v kapitole deváté. Závěr knihy je

věnován vkládání obrázků, grafických objektů, úpravám textů (WordArt) a jiným možnostem, jak data

vzhledově zatraktivnit. Obsahově tedy kniha přináší solidní základ pro nejběžnější využívání progra−

mu a může být dobrým odrazovým můstkem pro další studium. Kniha se snaží o maximální srozu−

mitelnost a omezuje výklady některých teoretických pasáží. Inspirací pro výběr témat a zpracování

knihy mi byla vynikající publikace Josefa Pecinovského Excel 2002 z edice podrobný průvodce

začínajícího uživatele, vydaná nakladatelstvím Grada v roce 2001. Mnoho zajímavých příkladů

a možností využití Excelu v praxi naleznete v knize téhož autora a nakladatele, která se jmenuje

Excel v příkladech.

Komu je kniha určena

Zaměření knihy

Co je obsahem
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Používané konvence
Pro snazší orientaci v knize jsou použity následující typografické prvky:

Kurziva označuje názvy softwaru a softwarových firem.

Tučně jsou zvýrazněny důležité pojmy, internetové adresy, názvy dialogových oken, polo−

žek a tlačítek a příkazy z nabídek programů, např. Soubor → Otevřít.

Pro zdůraznění kláves a klávesových zkratek jsou použity KAPITÁLKY.

Kromě toho se v textu setkáte s množstvím ikonek, které označují jiné typy odstavců:

Symbolem poznámky bude uveden odstavec, který rozšiřuje probíranou problematiku o nějakou

zajímavost či výjimečnost.

Symbol vykřičníku upozorňuje na úskalí, se kterým se můžete při práci setkat, a je proto dobré

zůstat stále ve střehu.

Tato ikona nabízí zpravidla nějaké usnadnění nebo tip, kterým si oproti standardnímu postupu

můžete práci ulehčit.

Narazíte−li na uvedenou ikonu, jedná se o odkaz na soubory, které dané téma procvičují, a které

naleznete na webových stránkách nakladatelství.

Ikonka se symbolem činek uvozuje tipy a náměty k procvičení daného tématu, případně otázky,

navazující na probraný problém, jejichž odpověď by vám již neměla činit problémy.

Tento symbol vás upozorní na shrnutí problematiky popisované v dané kapitole.

C
vi
če

ní-
námět-otázky
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Seznámení
s Excelem

Možnosti využití Excelu

1.

1.1 Spuštění programu

Excel je tabulkový procesor (kalkulátor), který snad ani nepotřebuje dlouze představovat. Jeho před−

ností využívá miliony uživatelů na celém světě, jež oceňují jeho univerzálnost a opravdu širokou

paletu možností využití. Vedle účetních příkladů lze Excel  využívat i v mnoha dalších oborech

lidské činnosti jakými jsou například věda a technika, řízení firem, řízení domácností a mnoha

dalších. Excel  může také naplňovat roli databáze, či pomocníka při plánování. Dříve než se pustíme

do vlastních tabulek a výpočtů, měli bychom Excel  poznat a spřátelit se s ním.

1.1 Spuštění programu
Spustit Excel je velice snadné a my si nyní ukážeme několik možností, jak to provádět. Okno progra−

mu Excel spouštíme z nabídky Start → Programy → Microsoft Office → Microsoft Office Excel

2003 (viz obr. 1.1).

Je−li na ploše zobrazena ikona programu Excel, lze dvojitým kliknutím spustit program také pomocí

této ikony (viz obr. 1.2).

Jak spustit Excel
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1. Seznámení s Excelem

Další z jednoduchých možností spuštění Excelu se skrývá pod tlačítkem Start.

Výběrem položky Spustit otevřeme dialogové okno, do něhož zapíšeme název

programu, v našem případě „Excel“ a potvrdíme (viz obr 1.3).

Spustit Excel  a zároveň otevřít požadovaný soubor lze provést v Průzkumníku,

poklepáním na vybraný excelovský soubor. Automaticky tak otevřeme nejen

Excel, ale i tento soubor.

Abychom mohli program otevřít, je nutné ho mít správně nainstalovaný. Instalace Excelu je

jednoduchá a průvodce instalací, jenž se automaticky spustí při vložení originálního CD Micro−

soft Office, vás krok za krokem provede jejím průběhem.

Pokud na ploše ikonu programu (zástupce) nenaleznete, lze ho přidat tak, že najedete myší

na položku programu v nabídce Start → Všechny programy a se stisknutou klávesou CTRL

a stisknutým levým tlačítkem myši přetáhneme položku do prostoru plochy.

Obr. 1.1: Spuštění programu Excel

Obr. 1.2: Ikona

Excelu na ploše

Windows

Po
známka

Tip
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Někdy se stane, že máme spuštěno několik aplikačních oken současně. Všechny postupně mini−

malizovat by bylo poněkud zdlouhavé, proto lze odkrýt plochu pomocí ikony Zobrazit plochu
na panelu  Snadné spuštění  .

1.2 Klíčové součásti Excelu
Protože již umíme Excel spouštět, zaměříme se nyní na základní součásti prostředí programu. Při každém

otevření máme všechny součásti k dispozici a lze jich tedy využívat při naší činnosti. Základními

součástmi prostředí programu, které vidíme při spuštění aplikace, jsou: Okno aplikace, Záhlaví, Panel

nabídek, Panel nástrojů, Podokno úloh, Řádek vzorců a Stavový řádek.

Okno aplikace
Spuštěním programu Microsoft Excel  se automaticky otevře okno aplikace (viz obr. 1.4), Horní pruh,

v němž se zobrazuje název aplikace a název otevřeného souboru, se jmenuje Záhlaví okna; spolu

s Panelem nástrojů, Panelem nabídek (ikony a nabídky pod záhlavím) a s okraji okna aplikace,

vymezuje pracovní plochu programu. Zde jsou také umístěna okna dokumentů. V pravé části apli−

kace naleznete Podokno úloh (Task Pane).

Záhlaví
Záhlaví obsahuje název programu, v našem případě Microsoft Excel (viz obr. 1.5). Máme−li otevřen

konkrétní dokument, je za názvem programu zobrazeno i jméno tohoto dokumentu. V levé části záhlaví

aplikačního okna je systémová nabídka – skrývá se pod zmenšenou ikonkou Excelu. Systémová nabídka

obsahuje příkazy operací, které využijete při ovládání aplikačního okna (viz obr. 1.6) Na pravé straně

záhlaví naleznete tři ikonky, jejichž pomocí můžete provádět změnu velikosti aplikačního okna a uzavření

aplikace. Funkce uvedených ikon jsou standardní a bezpochyby je již znáte z používání Windows.

Panely nástrojů a Panel nabídek
Příkazy, které naleznete pod záhlavím, se nazývají Panel nabídek (Commands), tlačítka a rozbalo−

vací seznamy pod panelem nabídek označujeme jako Panely nástrojů (Toolbars). Panely nástrojů

zpřístupňují důležité příkazy Excelu. Jedná se o obvyklé nástroje všech aplikací balíku Microsoft

Office, takže pokud je již využíváte například ve Wordu, nebudou pro vás neznámé.

Obr. 1.3: Spuštění programu Excel z nabídky Start

Po
známka

Součásti Excelu

Okno aplikace

Záhlaví
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Obr. 1.5: Záhlaví aplikačního okna

Obr. 1.6: Systémová

nabídka

Panel nástrojů
a Panely nabídek

Obr. 1.4: Okno aplikace

Aplikace Excel obsahuje nepřebernou paletu předdefinovaných nabídek

a nástrojů, které můžeme libovolně využívat. Zatímco v panelu nabídek

jsou povely, jež se zpravidla ještě dále větví a nabízejí mnoho voleb,

příkazy z panelu nástrojů provedou jednu konkrétní operaci (např. změ−

nu formátu aj.). Pro jejich využívání stačí klepnout na požadovaný ná−

stroj nebo nabídku. Výchozí nastavení programu zobrazuje Panel nabí−

dek a Panely nástrojů Standardní a Formát (Standard a Formatting)

a právě tyto dva panely budete využívat asi nejčastěji. Možnosti Panelu

nástrojů a Panelu nabídek se pružně mění podle toho, zda v Excelu

pracujeme s grafem, tabulkou nebo obrázkem.
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Některá odborná literatura panely nástrojů a panel nabídek nerozlišuje a pro oba používá

jednotný termín  Panely nástrojů, v této knize je budeme rozlišovat.

Obr. 1.7: Panel nabídek

Obr. 1.8: Panel nástrojů

Zobrazení Panelu nabídek a Panelu nástrojů
Panel nabídek je v aplikačním okně zobrazen stále, Panely nástrojů lze upravovat, pozměňovat,

případně je můžeme úplně skrýt a opět zobrazit. Pokud se rozhodneme některý z panelů nástrojů

zobrazit či skrýt, zvolíme v nabídce Zobrazit → Panely nástrojů (View → Toolbars).  Zaškrtnutím

požadované volby v dialogovém okně Panely nástrojů (Toolbars) (obr. 1.9) rozhodneme, které

panely nástrojů se zobrazí a které budou naopak skryty. Chcete−li některý z panelů nástrojů upravit

tak, aby zobrazoval jiné příkazy než jsou nastaveny implicitně, lze to provést v nabídce Zobrazit →
Panely nástrojů → Vlastní (View → Toolbars → Customize). Aby nám málo používané panely

nástrojů nezabíraly zbytečně místo na obrazovce, necháváme je většinou skryté. Panely nástrojů

se zpravidla zobrazují v oblasti okna. Jejich polohu můžeme ovšem měnit tažením myši za záhlaví

vybraného panelu nástrojů.

Chcete−li panel nástrojů vrátit na původní místo, klikněte myší dvakrát na jeho záhlaví.

Z široké nabídky panelů nástrojů využijete nejčastěji panely nástrojů Standardní (nejvíce používa−

né funkce při práci s dokumentem) a Fomát (základní úpravy vzhledu).

Změnu zobrazených panelů nástrojů můžete provádět z místní nabídky tak, že kliknete pravým

tlačítkem myši na libovolný panel nástrojů a zvolíte požadovaný panel nástrojů.

Kromě panelů nástrojů Standardní a Formát můžete často využívat např. panely nástrojů Graf

(Chart) (nástroje pro úpravu grafů), Obrázek (Picture) (nástroje pro změny v obrázcích), Kontin−

genční tabulka (Pivot Table) (průvodce a správa kontingenční tabulky), Podokno úloh (Task Pane),

Word Art (WordArt) (úpravy textů) a mnoho dalších.

Úpravy panelů nástrojů
V některých případech se stává, že potřebujeme často používat určitý příkaz z panelu nástrojů, který

máme obvykle vypnutý. Jak jsem již zmínila, Excel umožňuje přizpůsobit panely podle vlastní potře−

by a přesouvat příkazy mezi panely. Vybereme−li z panelu nabídek Zobrazit → Panel nástrojů →
Vlastní (View → Toolbars → Customize), otevře se dialogové okno pro úpravy panelů (obr. 1.10).

Na kartě Panely nástrojů (Toolbars) zapínáme a vypínáme zobrazované panely. Jiné uspořádání

příkazů na panelech můžeme nastavit na kartě Příkazy (Commands), přidávat příkazy do panelů

Up
ozornění

Tip

1.2 Klíčové součásti Excelu

Tip

Přizpůsobování panelů
podle vlastní potřeby
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nástrojů Standardní a Formát pod tlačítkem

Přeuspořádat příkazy (Rearrange Commands)

(obr. 1.11). Karta Možnosti (Options) nabízí

nastavení vlastností zobrazování příkazů

od různých animací, přes velikosti zobrazova−

ných ikon až po umístění panelů nástrojů.

Někdy se vám také stane, že požadovanou iko−

nu pro vybraný příkaz v zapnutém panelu ná−

strojů nenaleznete. Je to proto, že Excel v rámci

úspory místa málo využívané příkazy (resp. je−

jich ikony) automaticky skrývá. Zobrazit skryté

příkazy panelu nástrojů lze pomocí ikony .

Pokud vám automatické skrývání příkazů nevy−

hovuje, zaškrtněte volbu Vždy zobrazovat úpl−

né nabídky (Always show full menus) na kartě

Možnosti (Options), volbou příkazu Zobrazit

→ Panely nástrojů → Vlastní (View → Tool−

bars → Customize)(viz obr. 1.12).
Obr. 1.10: Úprava panelů nástrojů

Automatické skrývání
příkazů

 Obr. 1.9: Výběr zobrazovaných panelů nástrojů
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Plovoucí panely nástrojů lze ovládat obdobně

jako aplikační okno. Křížkem   v pravé části

panelu je zavíráme.

Stavový řádek
Stavový řádek je umístěn v dolní části okna

a zobrazuje některé informace o Excelu. Zpravi−

dla se v něm objevuje slovo Připraven (Ready),

čímž je vyjádřeno, že sešit je připraven k práci.

V případě úprav některé z buněk se objeví hláše−

ní Zadání (Enter) nebo Úpravy (Edit). Další

mohou být oznámení, zda je zapnuta numerická

klávesnice, SCROLL LOCK, CAPS LOCK  apod. Stavový

řádek může také fungovat jako rychlá kalkulačka

označených hodnot. Kliknutím pravým tlačítkem

myši vyberete typ početní operace, jíž chcete

na stavovém řádku zobrazit. Vyberete−li pak po−

žadované buňky, zobrazí se ve stavovém řádku

výsledek početní operace (obr. 1.13). Pokud sta−

vový řádek nevyužíváme, lze jej skrýt zru−

šením zaškrtnutí políčka Stavový řádek (Sta−

tus bar) na kartě Zobrazit (View) příkazem

z nabídky Nástroje → Možnosti (Tools →
Options).

Okno dokumentu
Místo, v němž se odehrává nejvíce z našich

činností, je Okno dokumentu (Workbook

Window). Okno dokumentu, stejně jako

okno aplikace, obsahuje záhlaví s názvem

dokumentu a tlačítka pro uzavření či změ−

nu velikosti. Při otevření nového dokumen−

tu se v záhlaví dokumentového okna obje−

ví název Sešit1 (Sheet1), pokud dokument

přejmenujeme, zobrazí se v záhlaví již nový

název.

Obr. 1.11: Karta Přeuspořádat příkazy

Po
známka

Obr. 1.12: Zobrazování úplných nabídek na panelu

nástrojů

1.2 Klíčové součásti Excelu

 Obr 1.13: Stavový řádek

Části okna dokumentu

-
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 Obr. 1.14: Okno dokumentu

Buňky
Nejdůležitější pracovní jednotkou excelovského dokumentu je Buňka (Cell). Buňky jsou políčka

mřížky, která obsahují data a funkce, a lze je mezi sebou propojovat. Kromě toho můžeme provádět

s buňkami i různé činnosti, lze je formátovat, vypočítat, přesouvat, kopírovat a odkazovat se na ně.

Pokud chceme do buňky vepsat data nebo vložit funkci, najedeme kurzorem na požadovanou

buňku a s pomocí klávesnice nebo funkce Vložit (Insert) vepíšeme požadovanou hodnotu nebo

vložíme funkci. Umístění buňky v mřížce určuje její polohu (adresu), což využijeme ve vzorcích,

funkcích a při odkazech na buňku. Odkazy na buňky mohou být v jednom listu, v sešitu, ale i v jiném

dokumentu. Využití adres buněk si ukážeme v dalších částech knihy. Adresa buňky vychází z čísla

řádku a písmene sloupce, resp. z jejich průsečíku. Pro popis sloupců používá Excel písmena abece−

dy (A až Z) a jejich kombinace (např. BZ), pro popis řádků pak číselnou hodnotu. Výsledkem pak

může být například označení B4, viz obr. 1.15.

Pro vyjádření adresy buňky lze také použít tzv. RC formát (řádek/sloupec, resp. Row/Column)

kde „R“ označuje číslo řádku a „C“ číslo sloupce. Použití tohoto typu adresy buňky nastavíme

zaškrtnutím volby  Styl odkazu R1C1 (R1C1 Reference Style) na kartě  Obecné (General)
v nabídce  Nástroje → Možnosti (Tools → Options). Adresa např. buňky C5 je R5C3.

Po
známka

Nejdůležitější pracovní
jednotka
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